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Visual3D Quick Reference Guide
1: Static Trial. Select type of model from Model menu. Use Create (Add Static Calibration
File) and pick Visual3D Hybrid Model.

Next, select static trial from Vicon database (e.g., \Vicon\Userdata\Gaitlab\...).
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2: Modeling. Apply a template from a previous subject that uses the same marker set. Be sure
that the subject’s name is not include with the target labels. The Options menu in Vicon
Workstation can remove the subject’s name.

Select a model template file (.mdh) from a similar project that used the same marker set. Note if
your data does not include one or more of the required markers refer to the Appendix for how to
create a landmark, e.g., left and right iliac crest.
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3: Body Parameters. Set subject’s mass (in kilogram) and height (in metres).

Enter the correct mass and height.

Save the model (.mdh) using the item, Save
Model Template.
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4: Add Motion (Dynamic) Trials. From the File menu add one or more dynamic trials of this
subject from the Vicon database area.

Select, Add the new files to your currently open files.

Use the Ctrl key to select more than one trial.
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5: Assigning Model. Worksheet will look like this before motion files have been assigned to a
model template.

Next from Model menu select Assign Model to Motion Files. Select each motion trial one at a
time. Be sure to hold the CTRL key down each time you select a file. There may be a long
pause before the model is fully applied to all frames in the trial.
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6: Force Plate Offsets. Worksheet will now look like this. Double-clicking a motion file will
start animating the data.

If necessary, set the Zero
Baseline Interval for the
force platforms. First click
on a particular file then
select the Modify Force
Platform Parameters item
from the File menu. Press
the Get Current C3D
Parameters button and
enter the correct region.
For gait initiation these
numbers should point to
the end of the file.
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7: Gait Events. Add event codes to each trial. One way is use a Pipeline command. Click the
Pipeline icon or press F11. Then select Automatic_Gait_Events from the Event area.

Enter 15 newtons in the FP threshold window and check the Z window in the FP Gravity
Direction frame. The Use Pattern Recognition to Create (L/R)HS and (L/R)TO labels must also
be checked. A frame window of 8 or larger is sufficient to prevent multiple adjacent events.
Press Done when complete. 

If ALL_FILES is selected in the window beside the Pipeline icon event labels will be determined
for all loaded trials, otherwise a single trial will be analyzed. Press the Execute Pipeline button to
start the procedure. Next Remove the Automatic_Gait_Events from the pipeline.

8: Save the Worksheet .CMO File. Be sure to save your worksheet. The file has a .CMO
extension and contains copies of each trial’s .C3D file, the model(s) template(s) and the report
template. You can also add tags to identify various trial and subject characteristics, such as,
gender, dominant foot, gait speed, footwear etc.
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9: Processing. Clear the pipeline then execute the script that will compute the various
kinematic and kinetic quantities. The usual script is Process Vicon Data. This Visual3D script
(.v3s) file should be in the subdirectory, Scripts, in the Visual3D work directory. From the
Pipeline form press the button, Open Script File then select file and press the Execute Pipeline.

This command may take some time to complete depending on the size of the files and the
number of files to be processed. Many more items have now been added to the data tree. Check
the Signal and Event Processing tab and view the areas KINETIC_KINEMATIC and
LINK_MODEL_BASED branches.
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10: Reporting. Next, select an appropriate report template depending upon the type of motion
analyzed. For example, select Gait Initiation, Gait Termination, Walk Analysis or Run Analysis.
From the File menu select Open Report Template then open the correct file.

11: Special Events. Before any data are graphed in the Reporting area the correct event codes
must be identified in the Signal and Event Processing tab. Select this tab and then add the
appropriate events such as, Begin trial and End trial or Begin stride and End stride or BeginR,
BeginL and EndR, EndL. Press the Event button at the top of the form on the right side.

You will need to press the Recalc button (beside the Pipeline button) after each trial’s event
codes have been added. There will be a short delay each time.

Be sure to save your worksheet. The file has a .CMO extension and contains copies of
each trial’s .C3D file, the model(s) template(s) and the report template. You can also add tags to
identify various trial and subject characteristics, such as, gender, dominant foot, gait speed,
footwear etc.
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12: Reports. After entering each pair of events click on the Reporting tab to see the effects to
the various pages in the Reporting area.

13: Export the Graph to a Document. Be sure to save your worksheet first. Right-click on
the graph page that you want to export then select, Export   <, then either As Bitmap or To
Clipboard.
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14: ASCII Export. To export the data in ASCII format to a
spreadsheet or graphics program first press the Signal and Event
Processing tab. Next, check the ORIGINAL folder in the
LINK_MODEL_BASED branch.

Then open the Pipeline (F11) and remove all entries by pressing
the Clear Pipeline button.

From the File branch, add (Add >>>) the command,
Export_to_Ascii_file, then press the Insert Checked Signals from
Tree button. Press the Edit button.

Enter a filename in the first
window. Use the Browse button so
the that the full path is included.
Right-click the first item in the
signals listbox and click on both
Select Start Event and Select End
Event options. You may want to
check the Normalize Data box
and/or the Export Mean and
Standard Deviation box. Press the
Done button. To complete the
export press the Execute
Pipeline button and then the
Cancel button.

Be sure to save your worksheet and exit.



12

Appendices
Creating Segments. If you want
to add or modify a segment, for
example, apply the landmarks
created in the previous section to
the pelvis segment first click on the
Model Building tab from the main
menu then press the Segments tab
and either double-click on the
Pelvis item in the list labeled
Double-Click Segments to
View/Edit or select it from the drop-
down list labeled Segment Name
(see figure on right). The form
shown below will appear beside the
display of the current model.

S
elect the R Iliac crest for the Lateral proximal end
of the pelvis and L Iliac crest for the medial
proximal end. The Distal lateral and medial ends
should be the RHIP and LHIP markers,
respectively. Be sure to select the correct tracking
markers in the area labeled Select Tracking
Targets. Click on the first tracking marker, e.g.,
LASI then hold the Ctrl key and click on all the
other tracking markers for the selected segment. In
this case select, LPSI, RASI and RPSI. You could
also include the hip markers. Note that when
selecting multiple items from a list, each one will
become highlighted if the Ctrl key is held down, if
not only the last item clicked will be selected. You
need a minimum of three tracking markers for each
segment. These markers should not be on the same
straight line. Finish by pressing the Build Model
button.
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Defining Segments Ends and Segment Coordinate Systems. The first step in creating
a local segment coordinate system (SCS) is the establishment of the frontal plane. Visual3D
allows the user to place either one or two border targets at each end of the segment during
subject calibration. Thus, the SCS can be created using two targets (a single border target at each
end), three targets (two border targets at one end and a single border target at the other) or four
targets (two border targets at each end). 

Figure 1. If three border targets are used then the frontal plane is
simply the plane define by the three targets. 

Figure 2. If four border targets are used then a least squares
plane is fit to the four targets. The least squares fit is applied
such that the sum of squares distance between the targets and the
frontal plane is minimized. 

Figure 3. If only two border targets are used then an extra
assumption (constraint) must be supplied. In the two-target case,
the frontal plane is defined by the plane containing the two
targets and the Visual3D coordinate systems (V3CS) X axis. This
is equivalent to assuming that there is no internal-external
rotation of the segment with respect to the V3CS. 

While it is possible to define a segment with only two targets, we strongly encourage that each
segment has at least three calibration targets that are used to locate the proximal and distal joint
centers and define the frontal plane of the laboratory coordinate system (LCS). The two-target
case can be transformed to a three-target case by explicitly creating a virtual target from one of
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the two targets. In this way, the user has explicitly defined the frontal plane and will not be
surprised by the results.

Establishing the Segment Ends. After creating the frontal plane, Visual3D then
establishes the distal and proximal segment ends. It should be noted that for kinetic
computations, the joint center is assumed to be at the proximal end of the segment distal to the
joint. If three border targets are used on a segment, Visual3D creates one segment end at the
midpoint between the medial and lateral targets. At the opposite end, where only a single border
target is used, Visual3D first defines a circle in the frontal plane (SCS XZ-plane) at a distance of
one radius from the border target. Visual3D then establishes the segment end to be the point on
the circle such that the vector from that end to the border target will be perpendicular to the
vector connecting the two segment ends (Figure 2). If four border targets are used then the
midpoints between medial and lateral targets are used to define each end of the segment (Figure
2). If only two border targets are used then, each segment end is established by translating the
border one radius along the V3CS X-axis (Figure 2). Note, this translation is along the V3CS X-
axis and not along the X-axis of the user’s LCS (see Chapter 13 regarding the relationship
between the V3CS and the LCS). 

Establishing the SCS X-, Y- and Z-Axes. The SCS Z-axis is determined by the unit
vector directed from the distal segment end to the proximal segment end. Next, the SCS Y-axis
is determined by the unit vector that is perpendicular to both the frontal plane and the Z-axis.
Finally, the SCS X-axis is determined by the application of the right-hand rule. From the above
discussion it can be seen that, the SCS Z-axis is directed from distal to proximal, the SCS Y-axis
is directed from posterior to anterior, and the SCS X-axis is medial-lateral in orientation.

Establishing the Origin of the SCS. The SCS origin is located along the line
connecting the segment ends (the SCS Z-axis) at the segment’s proximal joint.

Step-By-Step Procedure.

Step 1. The segment endpoints are calculated. As described in the Visual3D
documentation elsewhere, there are many ways to calculate the segment
endpoint. The relevance to the calculation is that the markers that are used to
define the segment endpoints also determine the frontal plane of the segment
coordinate system. In this illustration the three red markers are used to
calculate the blue segment endpoints 
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Step 2. The z-axis is defined by the vector from the distal segment endpoint
to the proximal segment endpoint. 

Step 3. The frontal plane (x-z) plane is defined by the markers. 

 Step 4. The y-axis is projected forward in the anterior posterior direction. 

Step 5. The x-axis is then calculated perpendicular to the y-z plane.
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Creating Landmarks. If you did not include the left and right iliac crests (for example) as
markers but instead applied markers to the left and right anterior and posterior superior iliac
spines you can create virtual markers, called landmarks, to
identify the lateral and posterior distal ends of the pelvis.
The following example shows how this is done. Note, that
there are several ways to create landmarks. First  press the
Model Building tab, then the Landmarks tab and the Add
New Landmark button. The landmark creation form (see
figure at right) will appear. Enter the landmark’s name in
the box labeled Landmark Name:, e.g., R Iliac crest.
Select RASI as the Starting Point. Be sure that the radio
button, Existing Segment: is selected and click on Right
Thigh. Select the radio button, Offset Using the Following
ML/AP/AXIAL Offsets. Enter offsets, in metres, in the next
three boxes, for example, 0.07, -0.07, 0.02. Press the Apply
button and a purple sphere with cyan centre will appear at
the location of the newly created landmark (see figure
below). You may have to change either of the three offsets
to precisely locate the landmark. Press Close Tab then
repeat for the left iliac crest (L Iliac crest) but change the
first offset to –0.07.
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- Starting point defined in Field 2

- Offset uses coord system in Field 3

- Actual offset specified in Field 4
(in meters)

- Field 2 is blank, so starting point 
is assumed to be (0,0,0) of coordinate 
system in Field 3

-Actual offset specified in Field 4
(in meters)

To Create a Landmark of Each Type
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Now, back to the tutorial…. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Fields 2 (reference)  and 3 define a line

- The landmark is on the line, as the result of
a right angle projection from Field 5

- Fields 2, 3 and 4 define a plane

- The landmark is in the plane, as a result of 
a right angle projection from field 5
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